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1 Document Information

This document describes how to get started with your Swissbit iShield Key FID0O2 [USB-A/NF(] (hereinafter referred
to as “iShield Key FID02"), and iShield Key Pro [USB-A/NF(C] (hereinafter referred to as “iShield Key Pro") security
key. The iShield Key FID0O2 and iShield Key Pro offer strong authentication that is simple, secure and flexible. They
also protect users against online attacks such as phishing, social engineering and account takeover.

The iShield Key FIDO2 supports FIDO2 and U2F standards to protect online accounts. The iShield Key Pro implement
a one-chip solution with multiple applets installed to support various use cases. The iShield Key Pro supports,
additionally to FIDO2 applications, generation of HMAC-based one-time passwords (HOTP) and personal
identification and verification (PIV). You can find an overview of supported use cases and references to more
detailed descriptions later in this document in section 2. Section 3 introduces the management tools
accompanying the security key. Eventually, the uses cases are explained by applet in section 4, section 5 and
section 6. Section 4 gives in-depth guidance on how to get started with the FIDO2 functionality, section 5 explains
the HOTP generation and usage and section 6 presents how to provision and use your iShield Key Pro key as a PIV
device.

In section 4, the iShield Key FIDO2 is utilized for all FIDO2 use cases since it shares the same functionality as the
iShield Key Pro. Sections 5 and 6 are specifically applicable to the iShield Key Pro and do not pertain to the iShield
Key FIDO2.

In the following, "iShield Key" will be used in scenarios where both iShield Key FID0O2 and iShield Key Pro are
compatible.

We highly recommend registering to the Swissbit Developer Portal. We will keep you up-to-date on important
product information. Additionally, you can subscribe to receive emails for new blog posts and other product
related content.

2 Overview iShield Key

Private Key @ Public Key HEEH Counter
(% Secret Key @ Certificate

HOTP Applet

FIDO Applet

User Account 1
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@UserAccountz
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&

PIV Applet

!@ User Authentication
<] Slot9A e.g. Smartcard Logon
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Digital Signature
Online Account

Authentication Encryption

e.g. Drive Encryption
using Bitlocker

User Account 4

Card Authentication
e.g. Physical Access

(o <) = [l st Koy 71002 uncionaty Generate one time passwords
iShield Key Pro functionalities

The Swissbit iShield Key FID02 security key has the FID02 applet installed only, and the Swissbit iShield Key Pro

oD )
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security key has the FID02, HOTP and PIV applets installed. In this section, you can find the functionalities that
support your use cases.

The following table guides you to the correct section in this guide for a more detailed description of your use
case:
Use Case Description Applet iShield iShield Reference
Key FIDO2 | Key Pro

Online Authentication User authentication for FIDO2 | FIDO2 section 4.2
and U2F compatible websites
and services \/ \/

2FA for Online Accounts / VPN | Two-factor authentication to | HOTP section 5.1
websites, services or VPN ‘/
supporting HOTP

Bitlocker — Local Account Drive encryption using Bitlocker | PIV section 6.5
for Local Windows Accounts ‘/

Bitlocker — Active Directory | Drive encryption using Bitlocker | PIV section 6.6
for Windows Active Directory \/
Domain Accounts

Windows Account Logon -  Logon into Windows Active | PIV section 6.7

Active Directory Directory Domain Account ‘/
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3 Swissbit Management Tools

3.1 IShield Key Manager Command Line Tool

The iShield Key Manager command line tool (iKMcli.exe) supports all required operations to manage the FID02,
HOTP (iShield Key Pro only) and PIV (iShield Key Pro only) applets on your iShield Key and assist the use cases
presented in this guide.

You can download the command line tool from the Swissbit iShield Key landing page.

We recommend adding the iKMcli to your path. Then you can execute operations as follows:

iKMcTli <command> <options>

The help of the iKMcli lists all commands and options. You can print the help by ikMc1i --help or
iKMc1i <command> --help for a specific command.

You can print the info for your iShield Key, including the serial number, by the command

ikMcli info --reader <reader>
To list all available smartcard readers and FIDO2 devices, use the following command:
ikmcli Tist
The detection of FID0O2 devices requires the execution of the command line tool as administrator.

There is one command for addressing the single applets installed in the iShield Key. In the following three
sections, the supported operations for FIDO2, HOTP and PIV are explained in more detail.

3.1.1  FIDO Command

The command fido for managing the FIDO2 applet provides an option to print information about your connected
FIDO2 device:

ikMcli fido --info
If no PIN is set yet, you can set a new PIN by
ikKMcli fido --set-pin <new pin>
You can change your PIN by
ikMcli fido --change-pin <new pin> --pin <pin>
To erase all credentials and the PIN, you can reset the FIDO2 device by
ikMcli fido --reset
You will be asked to touch the FIDO2 device to reset.
All these options for the fido command use the first detected iShield Key but you can also specify a FIDO2 device.
In order to execute an operation for a specific device, pass its path with the option —-fido-path <path>. You
can use the Tist command to list the paths of all connected FIDO2 devices.

The fido command requires administrator rights.
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3.1.2  HOTP Command
The command hotp has an option to show information about the HOTP applet on your iShield Key Pro:

ikKMc1i hotp --info
The info contains the version of the applet and the serial number of your iShield Key Pro.

The default PIN for authenticating an HOTP operation is 1234. You can change this factory default PIN by
ikMcli hotp --change-pin <new pin> --pin <pin>

The PIN must be between four and eight characters in length. You can optionally pass a format for the PIN with
the option --pin-format <ascii|hex>. If no PIN format is specified, ASCII format is assumed.

The command also offers the options to set the secret key and counter for the HOTP computation by the following
commands:

iKMcli hotp --set-key <key> --pin <pin>_ i
iKMcTli hotp --set-counter <counter> --pin <pin>

The secret key must be hex encoded and be of a length between 16 and 64 bytes and the counter must be a
positive integer. The factory value of the key programmed during device manufacturing is
3132333435363738393031323334353637383930 and the default of the initial counter value is 0. You can restore these
factory default values by

iKMcli hotp --restore-factory-key <key> --pin <pin>_ )
iKMc1i hotp --restore-factory-counter <counter> --pin <pin>

If you enter your PIN incorrectly 10 times, your PIN will be blocked irreversibly! You can still generate one-time
passwords but you will no longer be able to set a new secret key and counter and register your iShield Key Pro
for another application. Successful authentication of the PIN resets the retry counter.

The iShield Key Pro supports generation of one-time passwords of length 6 or 8 whereby 6 is the default length.
You can adjust the HOTP length by

ikKMc1i hotp --set-otp-length <length>

The hotp operations use the first detected iShield Key or you specify the smartcard reader to be used by the
option --reader <reader>. You can use the Tist command to print the connected smartcard readers.

3.1.3 PIV Command

The command piv also provides an option to print the version of the PIV applet installed on your iShield Key Pro
and your keys serial number:

ikMcli piv --info

Using the iShield Key Manager you can change the PIN, PUK and management key that are used to authenticate
PIV operations. The factory default for the PIN is 123456, the default PUK is 12345678 and the management key is
010203040506070801020304050607080102030405060708. You can change your PIN or unblock it by the PUK using
the following commands:

ikKMcli piv --change-pin <new pin> --pin <pin>
iKMcTi piv --unblock-pin <new pin> --puk <puk>

You can change the PUK using
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ikKMc1i piv --change-puk <new puk> --puk <puk>
A new management key can be set by

ikKMc1i piv --set-management-key <new key> --management-key <key>
You can list all certificates on the smartcard with the following command

ikMc1i piv --Tlist-certificates
In order to delete a certificate by its slot number use

ikKMc1i piv --delete-certificates <slot> --management-key <key>

If both PIN and PUK are blocked, you can reset your smartcard. This erases all PIV data and restores the default
settings.

ikKMc1i piv --reset

New values for the card holder unique identifier (CHUID) and card capability container (CCC) can be set with the
following commands:

ikMcli piv --set-chuid
ikKMcTi piv --set-ccc

Like the hotp operations, the piv operations use the first detected iShield Key. Alternatively, you can specify a

smartcard reader by the option --reader <reader>. You can use the 1ist command to print the connected
smartcard readers.
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L FIDO2 Applications (Standard)

4.1 Overview

The Swissbit iShield Key FIDO2 and iShield Key Pro are FIDO-certified plug-and-play security products that support
FIDO2 and U2F standards to protect online accounts. They provide strongest and most trusted hardware
authentication and allow users to securely access websites, applications, online services and company networks
such as Google, Microsoft, Salesforce, Amazon Web Services, etc. You can visit FIDO Alliance
(https://fidoalliance.org/fido2/) for more information. Swissbit provides a test website (https://fido.ishield.cloud/)
to allow users to test with Swissbit iShield Key.

This section explains FIDO2 registration and login and all FID02 functionalities are compatible for both iShield Key
FIDO2 and iShield Key Pro. Section 4.2 gets you started with your iShield Key and section 4.3 shows how to register
the key with various online services.

4.1.1  FIDO2 Registration

FIDO2 Registration

[
[

— VUV
FIDO Server

o 1. Request to register iShield Key for account
authentication

2. Request public key for account authentication
3. Reguest user PIN

L. User authenticates via PIN and touch

5. New public private key pair is generated on
ishield Key for the user account

6. Public key is sent to the online service

7. Online service registers public key for account
authentication

Identity Provider

iShield Key FID0O2

. < ° » @ m
< > — _@9_
> or

O=6

iShield Key Pro

When registering for an online service, the server requests a public key that it can assign with the user's account
for this one service for online authentication. The user will then be able to authenticate if they are in possession
of the corresponding private key. Using the iShield Key for FID02 registration, the user needs to authenticate with
the user PIN and touch the security key. The public private key is generated on the iShield Key hardware
authenticator and assigned with the user account. Lastly, the public key is sent to the server.
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4.1.2 FIDO2 Login

FIDO2 Login

1. Online service sends login challenge and user
account identifier

2. Request user PIN

3. User authenticatesvia PIN and touch
L_Login challenge is signed with private key
Identity Pravider assigned to user account

5_ Login challenge response is sent to online
L 3

service for verification
6. Login challenge response is verified
7. Account access is granted / denied

iShield Key FID0O2

F 3

-

,

@

iShield Key Pro

After successful FIDO2 registration, the online service has the public key for the user account and the
corresponding private key is stored securely on the iShield Key. The online service challenges the user to sign
with the private key. If the online server can verify the signature using the public key, the authentication is
successful and user is granted access to their account.

4.2 G@Getting started with FIDO2 Applications

4.2.1 Preconditions

The Swissbit iShield Key supports platforms and applications that are conform to FIDO/U2F/WebAuthn standards.
Following Platforms are supported:

e 0S:
o Windows 10,
o Mac0s,
o Llinux,
o Chrome 0S,
o Android
. Browsers:
o Firefox,
o MSEdge,
o Chrome,
o Apple Safari

4.2.2 PIN Setup of Swissbit iShield Key

Note: The Swissbit iShield Key is ready to use. If PIN is not required, jump to section 4.2.3

To manage the security PIN of the Swissbit iShield Key, a built-in functionality for security key management of
Windows 10 might be used.

Get your Swissbit iShield Key and windows computer ready.

To launch the security key management, please click "Start --- Settings --- Accounts", then choose the option
"Security key" and click the button “Manage"
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< Settings
@ Home Sign-in options
™ This option is currently unavailable—click to learn more
Find a setting pel
2= Windows Hello Fingerprint
PEEEs @ This option is currently unavailable—click to learn more
112 Windows Hello PIN
2 munfinks "a"  Sign in with a PIN (Recommended)
Security Ke
B Email & accounts ﬂ : .ty £ Y I S ke
Sign in with a physical security key

I Q, Sign-in options
Access work or school

A, Family & other users

Sync your settings Q

Q

Manage a physical security key that can log you into

applications.
Learn more
Password

Sign in with your account’s password

Picture Password
Swipe and tap your favorite photo to unlock your device

A pop-up window will prompt you to insert your security key into the USB port. Please insert the Swissbit iShield

Key.

In case the Swissbit iShield Key is recognized, then you can either choose to create or change the PIN for the
Swissbit iShield Key, which depends on whether there was a PIN stored previously. Meanwhile, the PIN of the
Swissbit iShield Key can be reset if it was lost or forgotten. Please note that the PIN and credentials will be

removed after resetting.

Windows Hello setup

::: Security Key PIN
' Creating a PIN for your security key helps keep you
secure

Add

Reset Security Key

Remove everything from this security key and reset to
factory settings

Reset

Close

X
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You could set up a new PIN if there is no PIN stored in it. To change the security PIN, the current PIN is required.

Windows Hello setup

Set up a security key PIN

bed

[
amn R R
amn |= security key PIN |
EEn
]
| Confirm security key PIN |

OK

Cancel

Windows Hello setup

Change your security key PIN

X

Ee:: urity key PIN

| |
| New security key PIN

| Confirm security key PIN

OK

Cancel

If you reset the Swissbit iShield Key, please note that the credentials are lost after reset.

Windows Hello setup

Reset Security Key

credentials on this key will be cleared.

Proceed

The security key will be reset to factory settings. All data and

Cancel

*

4.2.3 Test Registration

Please visit the test website https://fido.ishield.cloud, which supports WebAuthn, to test your Swissbit iShield

Key.
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The website looks like this:

B Swissbit iShield FIDO2 Test Site. X | - - X

8
<« C @ nhttpsy//fido.ishield.cloud % 1= $

iShield
FIDO2

test site

iShield FIDO2 Token

»

To register the Swissbit iShield Key, enter any name for credential ID, and click "Register"”

Windows Security

Security key setup

Set up your security key to sign in to fido.ishield.cloud as
testfidostick.

This request comes from Msedge, published by Microsoft
Corporation.

The security PIN is now required if a security PIN was setup as stated in section 4.2.2.
Note: If the security PIN is lost or not needed for your use case, move to section 4.2.2 to reset Swissbit iShield Key.
Please note that you have to register your key again after resetting.

After security PIN is accepted, you have to touch the end of the Swissbit iShield Key, to make sure that a human
is now operating it and not a machine. You will be prompted to touch your security key.

Now registration is completed. The Swissbit iShield Key is ready to be logged in.

4.2.4 Test Login

Please enter the Test ID that you registered before, and then click “Login"
Security PIN may be asked depending on whether the security PIN was set as stated in section 4.2.2. When
requested, touch the end of the Swissbit iShield Key to make sure a human is operating it.
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Windows Security X Windows Security x
Making sure it's you Making sure it's you
Please sign in to fido.ishield.cloud. Please sign in to fido.ishield.cloud.

This request comes from Msedge, published by Microsoft

This request comes from Msedge, published by Microsoft
Corporation.

Corporation.

Please enter your security key PIN. B

R ‘ |’5ecurit\; Key PIN ‘

Touch your security key.

OK Cancel Cancel

Finally, you will see the success message as shown below and the credential information about the Swissbit
iShield Key you used. It means that the Swissbit iShield Key is working properly.

(m] | B swissbitiShield FIDO2 Test Site. % | + - ] X

< C 3 httpsy/fido.ishield.cloud/dashboard 78 1=

You're logged in!

You just logged in using Web Authentication. Instead of using

a traditional, shared-key password, you used a piece of secure
hardware to create a strong, attested, and scoped credential
that is virtually unphishable! To keep learning about Web
Authentication and the FIDO2 framework, check out

Credentials for test_fido

*Credentials are stored for 24 hours.

Date created Raw 1D Public Key

Thu, 9:43AM UTC n9gjPlsmOBUITTe6zkZfSyrBpK6FXVBNTRfh  ----- BEGIN PUBLIC KEY----- MFkwEWYHKo71zj0CAQYIK -

Page 15 of 69



suwiissbit”®

4.2.5 Register Swissbit iShield Key on an online Microsoft account

You can easily sign into your Microsoft account with the Swissbit iShield Key without giving your e-mail address
and password. In this section, we will guide you how to register the Swissbit iShield Key on an “online" Microsoft
account. To log into an offline Microsoft account e.g. a local Windows PC account is not covered in this section.
Note: Please get your Microsoft account ready.

Visit https://login.live.com/ to login.

B® Microsofty
Sign in

Email, phone, or Skyp

5]

Mo account? Create one!

Sign in with a security key (2)

C% Sign-in options

After login, you will be directed to the main page. Click “Security” from the top blue bar and choose "“Advanced
security options".

[ | EE Microsoft account | Security x |+

& G 8] hitps://account.microsoft.com/security 8 {% ]

Microsoft account | Your info Privacy Security Rewards Payment 8 billing ~

Security basics

Manage your password, protect your account, and view additional security resources.

» 4
»
sec »
2.

Sign-in activity Password security Advanced security options
See when and where you've signed in and te! Help keep your account safer by using a Try the latest security options to help keep your
us if something looks unusual. stronger password. account safe.
View my activity Change my password Get started

On this page, you can manage your activated sign-in and verification options. Click “Add a new way to sign in
or verify" to add the Swissbit iShield Key as a security key.
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im} Y Additional security options x  + = o X
&« &} (3)  httpsy//accountlive.com/proofs/manage/additional?mkt=en-US8trefd =account.microsoft.com... 8 7= 3

Last update: 3/6/2021

Change >

Ways to prove who you are

Manage sign-in and verification options for your Microsoft account. Learn more about sign-in and verification.

~ [ Enter password © Uptodate
Last 3/6/2021 Used for Account sign in
changed
Change password View activity
> [ Emailacode © Uptodate
> D Text a code © Uptodate
> D Enter a code from an authenticator app © Uptodate

I @ Add a new way to sign in ar verify I

In the following page choose "Use a security key".

X
Select an Additional way to verify or sign

n

M\ Usean app
Quickly approve sign-in notifications on
your phone.

Email a code
Get an email and sign in with a secure
code.

o o Useyour Windows PC
~ Sign in using your face, fingerprint, or a
PIM.

Use a security key
These devices let you sign in without a
username and password.

Show more options

Connect your Swissbit iShield Key and click "Next". As the Swissbit iShield Key is an USB security key with NFC,
you could choose, either to plug it into your USB port, or to keep it close to your NFC reader.
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Payment & billing

i Microsoft account | Yourinfo  Privacy  Security  Rewards

et up your security key

Have your key ready

ﬂ USE device m NFC device

To use a USE security key, when prompted, plug it into your USB
port. Then touch the gold circle or button if your key has cne when

prompted for follow up action.

For detailed instructions on how your keys should be connected, please visit your key manufacturer's

website,

Follow the pop-up to setup your Swissbit iShield Key. Please note that Microsoft requires the user to create a PIN
for the Swissbit iShield Key.

Settina 1IN volir new sian-in
Windows Security

Continue setup

You'll need to create a PIN for this
security key.

R ‘ New Security Key PIN

‘ Canfirm Security Key PIN ‘

OK Cancel

After you finish your setup, you will see the success page as shown below.
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M) | 5% Setupyoursecurity key x 5=

[ G ] https:/accountlive.com/proofs/fido/provision 78

Microsoft account | Your info Privacy Security Rewards Payment & billing Services 8t subscriptid

You're all set!

Next time you sign in, you can use your security key instead of a password to sign in.

Add another security key

Meanwhile, you will receive an e-mail from Microsoft.

mm Microsoft account team <account-security-noreply@accountprotection.microsoft.com>
WE i, 09.02.2022 1626

An: Sie

Microsoft account
Security info was added

The following security info was recently added to the Microsoft account IR
¢ FIDO security key
If this was you, then you can safely ignore this email.

If this wasn't you, a malicious user has access to your account. Please review your recent activity and we'll help you secure your account.

Review recent activity

To opt out or change where you receive security notifications, click here.
Thanks,

The Microsoft account team

Back on the verification options page, your Swissbit iShield Key should already be listed and you can manage it
anytime (in the screenshot it is named “iShield FID02").

0 E¥ Additional security options x |+ -

&~ = O ()  https://account.live.com/proofs/Manage/additional & 1= 3

Ways to prove who you are

Manage sign-in and verification options for your Microsoft account. Learn more about sign-in and verification.

> [&3] Enter password © Uptodate

> [ Email a code © Uptodate

> D Text a code © Uptodate

> D Enter a code from an authenticator app @ Uptodate

v D Use a security key iShield FIDO2 © Uptodate
Key name iShield FIDO2 Used for Account sign in

Date added  2/9/2022

Last used 2/9/2022

View activity Remove
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4.2.6 Usernameless/Passwordless Sign-in on an online Microsoft account

As the Swissbit iShield Key is already registered on Microsoft, you can now sign in without an e-mail address and
password.

Visit https://login.live.com/ to login, and click "Sign in with a security key". If you don't see this option, click
"Sign-in Options" at the bottom and choose "“Sign in with a security key".

B® Microsoft
Sign in
Ema

MNo account? Create one!

r Skvne

3]

ISigP in with a security key (z::.l

@Q Sign-in options

Now plug in your Swissbit iShield Key, or keep it close to your NFC reader.
When your Swissbit iShield Key is detected, enter your PIN.

Windows Security >

Making sure it's you
Please sign in to login.microsoft.com.

This request comes from Msedge, published by Microsoft
Corporation.

Please enter your security key PIN.

Q |l |

0K Cancel

Now you are successfully logged into the Microsoft account.

4.2.7 Sign-in with external Identity Provider

If you want to setup Single Sign-0n with the Swissbit iShield Key, but your target service does not support
FIDO/WebAuthn natively, then you can use an external Identity Provider like Keycloak. In the following section,
we will demonstrate how to setup Single Sign-0n with Keycloak and your Swissbit iShield Key.

This demo consists of two parts. A Dracoon App (“Dracoon”) which is a third party cloud service provider and
Keycloak which is an open-source Identity and Access Management service.
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In this case, Dracoon requests Keycloak to authenticate a user and to secure themselves and provides a single
sign-on solution. A user, who has already enabled the passwordless login by registering his Swissbit iShield Key
with Keycloak as an identifier could log into Dracoon with his user name and Swissbit iShield Key without a new
registration. As a user is authenticated, Keycloak will then inform Dracoon that a user was successfully
authenticated and provides the identity information of this user. The type of identity information could be
configured and in this case, it is the e-mail address. Finally, Dracoon will create a new user if the user is not
registered.

The purpose of this guide is to walk through the steps that need to be completed for this demonstration. The
pre-requisite is that the basic settings of Keycloak and Dracoon are completed.

Configuration in Keycloak

Please note that you should finish adding an 0IDC client on Keycloak before starting. You can find the guide on
how to add and configure an OIDC client at https://www.keycloak.org/docs/11.0/server_admin/#oidc-clients.

> Fine Graln OpenlD Connect Conflguration
> OpeniD Connect Compatibility Modes
> Advanced Settings

> Authentication Flow Qverrides

In the screenshot above, we would like to go through some important configurations.

Client Protocol: As OpenID connect protocol is being used, this value should be "openid-connect”

Root-URL and BaseURL: This value should be the URL of your Dracoon service.

Valid Redirect URLs: This value should be the Dracoon link that you would like to redirect from. You can use
Wildcards(*) at the end of a URL.

Access Type: the type of 0IDC client. Please note that if it is set to confidential, the credential of clients must be
configured. "Client Id and Secret”" is the default setting of Client Authenticator. The secret is automatically
generated for future use. For more information you can visit
https://lwww.keycloak.org/docs/latest/server_admin/index.html#_client-credentials
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AKEYCLO
Clients dracoon
Dracoon
Realm Settings Settings Credentials Keys Roles Client Scopes § Mappers Scope Revocation Sessi
Clients . ;
Client Authenticator ¢ Client Id and Secret v

Client Scopes

Secret Regenerate Secret

Roles

Identity Providers

Registration access token Regenerate registration access token

User Federation

Authentication

Groups

Users

For other configurations of 0IDC client, please visit https://www.keycloak.org/docs/11.0/server_admin/#oidc-
clients for more information.

Please enable "WebAuthn Register Passwordless" in the tab "Required Actions"”, and then setup a passwordless
browser login flow. You can add it by following this guide
https://www.keycloak.org/docs/latest/server_admin/#creating-a-password-less-browser-login-flow.

After this flow has been created, click on Authentication and switch to the Tab “Flows". Then choose your flow
(In our example it is "Browser WebAuthn") from the drop down list. You can now manage the Authentication
types based on your use case. The screenshot shown below is an example of possible flow configuration, which
allows you to use either "WebAuthn Passwordless Authenticator” or "Password & OTP".

GEKEYCLO

More information can be found at https://www.keycloak.org/docs/latest/server

Authentication

Browser WebAuthn

Auth Type

Bindings Required Action: Password P OTP Palicy

Requirement
REQUIRED
REQUIRED
REQUIRED
REQUIRED
secuneo
oo
REQUIRED
REQUIRED
:;oumzu
REQUIRED
r:::ou-Rza

REQUIRED

New | Copy

ALTERNATIVE
ALTERNATIVE
ALTERNATIVE

ALTERNATIVE

ALTERNATIVE
pren—
:‘:l‘1EﬂNNWE
ALTERNATIVE
ALTERNATIVE

DISABLED

ALTERNATIVE

Delete | Edit Flow

DISABLED
DISABLED
DISABLED

DISABLED

DISABLED
DISABLED
DISABLED
DISABLED

DISABLED

DISABLED

Add execution

CONDITIONAL

CONDITIONAL

CONDITIONAL

CONDITIONAL

Add flow

admin/#_authentication-flows.
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Configuration in Dracoon

OpenlID connect protocol is used for the communication between Keycloak server and Dracoon.
Please note that you should complete your basic setup of Dracoon before starting.

Click "System settings --- Authentication", switch to the tab “OpenlID Connect”
DRACCON a
Back to all files Authentication

Administration OpenlD Connect

Users

Groups OpenlD Connect el .
Enable login with OpeniD Connect
Y OpeniD g P @
Configuratior v
OpenlD Provider Add
System
Swissbit /2 X

Policies
Security
Apps

ES Authentication
Storage
Logging
Subscription

Branding

Click "add" to add a new profile. This means Keycloak is applied as the Identity provider. (In the screenshot
above, "Swissbit” is the profile name). The configuration value of Identity Provider can be fetched from
<Keycloak- URL>/auth/realms/{realm-name}/.well-known/openid-configuration. This link is a JSON document
describing metadata about the Identity Provider.
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developer. fauth/realm: X +

C

JSON Raw Data Headers

Save Copy Collapse All Expand All Y Filter JSOI

v issuer: “https://developer. NG/ cuth/realms A
swissbit

¥ authorization_endpoint: “https://developer. N o.th/realms
/Swissbit| N ctocol/openid-connect/auth”

¥ token_endpoint: “https://developer.  NGNGNGNGEGM cuth/realms
SSwissbit| I »-otocol/openid-connect/token™

¥ introspection_endpoint: "https://developer. NI outh/realms
/Swissbit| I - -ctocol/openid-connect/token
Jintrospect”

w» userinfo_endpoint: “hitps:/Sdeveloper . NI . th./ realms
Sswissbiti - ctocol/openid-connect/userinfo”

* end_session_endpoint: “https://developer . I - .th/ realms
SswissbitiEE -otocol/openid-connect/Logout”

* juks_uri: “https://developer . I - .th/ realms
SswisshbitiE -rotocol/openid-connect/certs”

w check_session_iframe: “https://developer . I - .th/ realms

/Swisshiti N - otocol/openid-connect/Login-

status-iframe.html"

w grant_types_supported:

a: "authorization_code”
1 "implicit”
2 "refresh_token"
3: "password”
4 "client_credentials”
5: "urn:ietf:params:ocauth:grant-type:device_code”
6: "urn:openid:params:grant-type:ciba”
» response_types_supported: [..]
» subject_types_supported: [..]
b id_token_signing_slg_values_supported: [..]
b id_token_encryption_alg_values_supported: [..]
» id_token_encryption_enc_values_supported: [o]
» userinfo_signing_slg_values_supported: [..]
b request_object_signing_alg values_supported: [.]

P response_modes_supported: [.]

w* registration_endpoint: “hitps:/Sdeveloper . NI . th./ realms
SSwissbit| . -.icnts-registrations/openid-

connect”

w token_endpoint_auth_methods_supported:

The configuration value that you got from above should be entered in Dracoon as shown below.
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Configure OpenlID Provider

Swisshit]

https://developer. I 2uth/realms/Swissbit NN

https://developer. I auth/realms/Swissbit [N

https://developer. I 2uth/realms/Swissbit IR

m
o
=

ser Info Endpoint URL: * https://developer I auth/realms/Swissbit I

https://developer. I =uth/realms/Swissbit NN

%
[

email S

Scopes:? openid O @

https:// . dracoon.cloud @

Authorization Code v

of Key for Code Exchange (PKCE ]

Cancel Save

As a final step, save the settings using the Save button. OpenID can now be used as an authentication method in

Dracoon.
You can visit https://cloud.support.dracoon.com/hc/en-us/articles/360001372679-0penlD-Connect-Keycloak for

more Information about OpenlID connect client configuration.

Swissbit iShield Key Registration

When the user authenticates on the account site of Keycloak, the user may choose multiple ways to sign in. You
can find the account site at : <Keycloak-URL>/auth/realms/{realm-name}/account/

Expand "Account Security" and then click the "Signing In" option and set up a new Security Key by clicking the
configure symbol. In the screenshot below the user has not configured any security key.
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Log in by entering your password. 5
Personal Info

Account Security v My Created: Update

Password January
Signing In 21, 2022,

3:43 PM
‘ Device Activity

Applications Two-Factor Authentication

Authenticator Application
Enter a verification code from authenticator

application.

Authenticator Application is not set up.

Passwordless

Security Key E

Use your security key for passwordless log in.

Security Key is not set up.

Please follow the instructions to finish setting up your Swissbit iShield Key. The registered Swissbit iShield Key
are listed below. In the screenshot above, the user has configured one passwordless security key (in screenshot
it is named “ishield FIDO2")

Password January — -
Personal Info 21, 2022,
3:43 PM
Account Security A
Al Two-Factor Authentication

Device Activity
| Authenticator Application
Applications Enter a verification code from authenticator

application.

Authenticator Application is not set up.

Passwordless

Security Key

Use your security key for passwordless log in.

WebAuthn Created:

Authenticator lanuary
(iShield FID02) 24, 2022,
5:32 PM

Single Sign-0n Test
Now it is time to test the Single Sign-0n functionality.

Visit the Dracoon website or app and there should be two login options. Choose "Login with <Profile Name>".
(In the example below it is, "Login with Swissbit")
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DRACCON

Other login option

Help Imprint Data privacy English

4

You will automatically be redirected to Keycloaks login interface. Then enter your user nhame and choose the
option "Use your security key for passwordless sign in" under the Sign in button instead of entering a password.

Password

Forgot Password?

Sign in by entering your password.

Use your security key for passwordless sign in.

Choose "Sign In with Security Key"

SIGN IN WITH SECURITY KEY

Sign in by entering your password.

Use your security key for passwordless sign in.

Follow the pop up instruction to log in. If your sign in is successful, you will be automatically redirected to
Dracoon. A new account is now created. You are now ready to use Dracoon.
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If something goes wrong or you cancel this process, you can see an error Info and the name of the registered
Swissbit iShield Key (in the screenshot it is named “iShield FID02").

Available authenticators

¢ WebAuthn Authenticator (iShield FID0O2)

Sign in by entering your password.

Use your security key for passwordless sign in.

4.3 Swissbit iShield Key on various services

In this section we would like to guide you how to register Swissbit iShield Key as a security key to enable 2-factor
authentication on various services.

4.3.1 Autho

Autho (https://www.autho.com/) is an identity provider like KeyCloak and it supports WebAuthn for multi factor
authentication. In this section, we will guide you how to enable the WebAuthn with FIDO on Autho.

As pre-requisite, you should get your Autho instance ready.

Go to Dashboard, Click "Security” and choose "Multi-factor Auth"

Q v Q Disc!
Development

4 Getting Started

Getting Started

% Activity FIRST

& Applications

£ Authentication

@ Try your Login box
i OrAaations m With Auth@ your authentication experience is ready to go. Customize it to
®+ User Management > match your brand identity and try it now to see how it works.

¢ Branding Tryitout > Customize -

¥ Security

Attack Protection

Multi-factor Awith

Invite your team members

Monftoring e gi; Add additional admins to help with your integration and act as a backup
& Actions > account in case you lose access.
L, Auth Pipeline > ® Learn more about Tenant Administrator permissions
1li Monitoring
=% Marketplace
®& Extensions Integrate Auth@ into your application
£ Settings é Add Auth@ to any kind of application and technology or use one of our

sample apps to get you started in minutes.

Click "WebAuthn with FIDO Security Keys"
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Authentication
Organizations m
User Management
Branding

Security

Attack Protection
Multi-factor Auth
Monitoring

Actions

Auth Pipeline
Monitoring
Marketplace
Extensions

Settings

Get support

Give feedback

sulissbit®

Multi-factor Authentication

Multi-factor Authentication works by requiring additional factors during the login process to prevent unauthorized access.

; Factors
Utilize push, SMS, email, one-time password, or a combination of different methods and easily enable them across all users and

applications.

WebAuthn with F[Dp Security Keys

V ® Disabled
Use WebAuthn-complant security keys

WebAuthn with FIDO Device Biometrics

) e Disabled
C/?) Use WebAuthn-compliant device biometrics

One-time Password
® Disabled
Provide a one-time password using Google Authenticator or similar.

Toggle the switch (1.) to enable the “WebAuthn with FIDO Security Keys"

For 2. Setting is shown below, you could change the verification condition when the Swissbit iShield Key is being
registred as a security key. If you choose "If supported” or "Required", a PIN is required when the Swissbit iShield
Key is being used as a second authentication factor.

AN

<

(0]
m}

Development

Getting Started
Activity FIRST
Applications
Authentication
Organizations [[E0)
User Management
Branding

Security

Attack Protection

Multi-factor Auth

Moni
Actions

Auth Pipeline
Monitoring
Marketplace
Extensions

Settings

Get support

Give feedback

Discuss your needs M Docs Qo

< ‘Backte MullEtactor Aithantication | (& WebAuthn with FIDO Security Keys is now enabled. X

WebAuthn with FIDO Security Keys 1L @

Depending on your browser, you can use WebAuthn-compliant security keys (like FIDO2) as a second factor of authentication. Learn more

User Verification
Verifies that the person authenticating is authorized to use the

security key by asking to enter a PIN or use a touch sensor.

© Never
The browser will not prompt for user verification

If supported
The browser will only require user verification if the

security key has user verification configured.

Required
The browser will always require user verification. This
setting will not work for FIDO1 keys and some browsers

Back to the previous content (Multi-factor Authentication), you could now define whether the Multi-factor
Authentication that you just enabled is always required. Click “Save" to save your setting. In the screenshot
below, "Always" means user is always required to use Swissbit iShield Key for authentication.
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lopment

Define policies

Policies determine when a user will be prompted to complete additional steps to prove they own a particular ac

4 Getting Started 2

nt. Use polic define

A Activity FIRST your level of acceptable risk. You can achieve more refined multi-factor configurations (ex. per application, per user, etc.) by using Rules.

& Applications

£ Authentication
= Require Multi-factor Auth
# Organizations (0 J
Define when users will be able to auth ate Never
&% User Management using an additional factor for all Appli Users are not required to use an additional factor to login
/.

Branding

¥ Security
Use Adaptive MFA ADD-ON
Atack Protection Users are required to have an additional factor if the login appears

to be a high risk. Contat{ Sales.

Multi-f

Monitoring

& Actions
Always

L, Auth Pipeline Users are always required to use an additional factor to log in.

1l1 Monitoring

«* Marketplace .
MFA Risk Assessors Enable Adaptive MFA Risk Assessment ADD-ON
& Extensions
¥ Settings Risk will be assessed and recorded for all login
transactions in your tenant logs. Adaptive MFA Risk

Assessment is required for enabling the Adaptive MFA

policy, but can also be used to implement custom MFA

policies using F

m Sancel

After this settings, as the security key is not registered, user is asked to add one.

I A
X
Adding Your Security Key

Security Keys can be used as an additio&al
authentication factor.

@ Connect your Security Key and continue.
@ Follow the steps on the browser.

Name your Security Key to easily identify it
later.

Use security key

Following the pop up to register your Swissbit iShield Key (in the screenshot it is named "iShield FID02"), then
you could give an alias for it.
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X
Name your security key |

Dracoon

If you own muiltiple keys, this alias will help you
identify the right one.

Security key name
( iShield FIDO2 ’

suwlissbit”®

Finally, you have successfully registered your Swissbit iShield Key. Now you could use it to login.

I A
X
N
Security key successful |
Dracoon

You have successfully registered your Security Key.

=r iShield FIDO2
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4.3.2 Bitbucket

After Login, go to the Personal settings and click "Two-step verification” under the security group. Then you can
see you must setup SSH on your account before you are able to enable the two step verification. You can visit
https://support.atlassian.com/bitbucket-cloud/docs/set-up-an-ssh-key/ for more information about SSH
configuration at Bitbucket.

it I Bitbucket Your work  Repositories  Projects More v

Personal settings

GENERAL Two-step verification =)

Account settings Make your account safer!

Email aliases Two-step verification secures your account by requiring a second confirmation, in addition to

Notifications your password, to access your account. That second step means your account stays secure even
if your password is compromised.

ACCESS MANAGEMENT
Get ready for two-step verification

App authorizations

It looks like you aren't quite ready to set up two-step verification on your account. You'll need to address the following items
before continuing.

App passwords

SECURRLY o Set up SSH on your account
SSH keys
Y Once you've enabled two-step verification on your account, you will only be able to clone, push, or pull your repository

Two-step verification over SSH. Your HTTPS access to Bitbucket repositories will be disabled. With SSH, you'll also be able to recover your

. account should you lose your device.
Sessions
Audit log Manage your SSH keys  Learn more about SSH
FEATURES
Labs 0 Confirm your primary email address

Your primary email is IEEEG—G—S (Change)

e Make sure you've updated any applications that connect to Bitbucket

Enabling two-step verification will disable all remote HTTPS actions for Git and the Bitbucket APl Any applications
which use HTTPS to access Bitbucket will be impacted. Learn more.

Once you've completed the steps above, simply return to this page to continue. See you soon!

After the SSH setup, visit “Two-step verification" site again, you are now able to enable the two-step verification
with an app. Please follow the guide to complete the setup.
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:: W Bitbucket

confirm that you are enabling two-step verification.

Your work

Personal settings

GENERAL
Account settings
Email aliases

Notifications

ACCESS MANAGEMENT
App authorizations

App passwords

SECURITY
SSH keys
Two-step verification
Sessions

Audit log

FEATURES

Labs

Repositories  Projects

Two-step verification

Setting up two-step verification is easy, just follow the steps below.

o Download a two-step verification app

" iPhone, iPod Touch, or iPad: Authy for iOS

W' Android devices: Authy for Android

== Windows devices: Microsoft Authenticator

h your verification app

e Enter the resulting verification code

Can't find your code? Get help.

Enable two-step verification

After that you will receive a confirmation Email from Bitbucket. Don't forget to click the link from the mail to

Q(_ Antworten @_ Allen antworten Q, Weiterleiten

An

Do 17.03.

Bitbucket <notifications-noreply@bitbucket.org>

022 14:24

[Bitbucket] Finish enabling two-step verification

Aktionselemente

W Bitbucket

Finish enabling two-step verification

To finish enabling two-step verification, we need to make sure that you're the

Time based: Yes

Can't scan the code? You can add the code to your application manually using the
following details:

Account: I
Key: 1226 z:20

A

+ Weitere Apps abrufen

one who set it up. Click the button below to finish enabling two-step verification.

Enable two-step verification

suwiissbit”®

Now you could register your Swissbit iShield Key as a security key at Bitbucket. Give the device name and klick

"Add security key" on the right side (in the screenshot it is named “iShield FID02").
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HH & Bitbucket Your work  Repositories  Projects More v

Personal settings

GENERAL Two-step verification

Account settings

Disable two-step verification

—_ Recovery codes
Email aliases

Notifications Show recovery codes

ACCESS MANAGEMENT Security keys

A thorizati ) ) ) o . O
PP:authonzations Security keys are hardware devices that you insert when signing in, replacing the need to enter a verification code. We only

App passwords support security keys that use the FIDO and FIDO2 standards.

To link a security key to your account, enter a device name, click Add security key, and then insert your security key and press

SEQURITY the device’s button.
SSH keys
Two-step verification Device name Added on Last used
Sessions iShield FIDO2 Add security key
Audit log
You haven't added any security keys.
FEATURES
Labs

Follow the pop-up instructions; finally, you have successfully registered your Swissbit iShield Key. Now you could
use it to login.

i W Bitbucket Your work  Repositories  Projects More v

Personal settings

GENERAL Two-step verification

Account settings

Disable two-step verification

Recovery codes

Email aliases
Notifications Show recovery codes
ACCESS MANAGEMENT Security keys

AR suthonzatons Security keys are hardware devices that you insert when signing in, replacing the need to enter a verification code. We only

App passwords support security keys that use the FIDO and FIDO2 standards.

To link a security key to your account, enter a device name, click Add security key, and then insert your security key and press

SECURITY the device’s button.

SSH keys
Two-step verification Device name Added on Last used
Sessions Add security key
Audit log

iShield FIDO2 just now Never [x]
FEATURES
Labs

4.3.3 Github

Go to settings, click “Password and authentication" under the tab "Access", then choose "Security keys" from
Two-factor methods.
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Old password
Appearance

I Accessibility

Notifications New password

5 Confirm new password
Billing and plans

] Emails
Password and authentication
Update password

D $SH and GPG keys

Organization

Moderation Two-factor authentication

Two-factor authentication adds an additional layer of security to your account by requiring more than just a password to
3 Repositories sign in. Y
) Packages
Two-factor methods

] Pages

Saved replies
Authenticator app

curity and anal Security keys

. b Mobile
3 Applications

Scheduled reminders
SMS number

2 Security log Recovery options
4, Sponsorship log
Recovery codes ()

Developer settings

Fallback SMS number

Now you should confirm your account recovery settings. Please note that you must finish setting up an
Authenticator app and Recovery code before next step.
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Confirm your account recovery settings

Are your account recovery settings up to date? If not, you risk getting
locked out of your account.

Two-factor methods

Authenticator app

Security keys (

GitHub Mobile

SMS number

Recovery options

Recovery codes

Fallback SMS number

Update Confirm

Now you can give a name for your Swissbit iShield Key (in the screenshot it named “iShield FID02").

Recovery codes Recovery codes can be used to access your account in the event you lose
access to your device and cannot receive two-factor authentication codes.

GitHub Support cannot restore access to accounts with two-factor

authentication enabled for security reasons, saving your recovery codes in a
safe place can help keep you from being locked out of your account.

o i

Fallback SMS number Providing a fallback SMS number will allow GitHub to send your two-factor
authentication codes to an alternate device if you lose your primary device.

For security reasons, GitHub Support cannot restore access to accounts with
two-factor authentication enabled. If you lose access to both your primary
device and your recovery keys, a backup SMS number can get you back in to
your account.

Delivery options Your primary delivery method is: authenticator application.

Security keys
verification code. Lez

iShield FIDO2|

GitHub Mobile GitHub Mobile can be used as your second factor of authentication instead of a
verification code. | about two-factor authentication with GitHub
Mobile.

To configure your device, install GitHub Mobile for iOS or / d and sign in
to your account.
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Follow the pop up instruction and finally you have successfully registered your Swissbit iShield Key. Now you
could use it to login.

Security keys Security keys can be used as your second factor of authentication instead of a
verification code. e about configuring a security key.

iShield FIDO2 — registered on Mar 22, 2022

Register new security key

4.3.4. Amazon Web Service (AWS)

After you log into the AWS Management console, click your ID at top-right side, and choose "Security credentials”
(1.). From the bottom you can find the option “Assign MFA device" (2.).

a\I-VE EEE Services Q @ Q @ Global ¥

Identity and Access Password for console access
Management (IAM) \ Account 1D:
As an IAM user, you need a password to acqEVNVETS=S

password is 16 days old. Learn more

Dashboard
Change password Account
v Access management
Organization
User groups
sate Access keys for CLI, SDK, & AP| e et
Use access keys to make programmatic call
Roles ) Y prog : . Billing Dashboard
maximum of two access keys (active or inac
Policies

; _ For your protection, you should never share [ iatalis AatsLUlC
Identity providers =
If you lose or forget your secret key, you

Account settings

Create access key Switch role

w Access reports

Access analyzer Access key ID Status Created Last use!
Y
Archive rules
] Active 2020-04-28 20:23 UTC+0100 N/A
Analyzers
Settings

Multi-factor authentication (MFA)

Credential report
P For increased security, we recommend configuring MFA to help protect your AWS resources. MF

Organization activity an approved authentication device when they sign in to AWS. Learn more

Service control policies (SCPs) Assign MFA device 2

Q Search

Choose "U2F security key" and click continue
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Manage MFA device x

Choose the type of MFA device to assign:

Virtual MFA device
Authenticator app installed on your mobile device or computer

® U2F security key
YubiKey or any other compliant U2F device

Other hardware MFA device
Gemalto token

For more information about supported MFA devices, see AWS Multi-Factor Authentication

Insert your Swissbit iShield Key and touch the end side of your Swissbit iShield Key. Your Swissbit iShield Key will
be automatically detected.

Set up U2F security key x

See information about supported configurations for using U2F security keys

1. Insert your U2F security key into your computer's USB port.

2. Tap the button or gold disk on your U2F security key.

Wiaiting for security key...

8 |

Troubleshoot U2F Cancel Previous

Finally, you have successfully registered your Swissbit iShield Key. Now you could use it to login.
Set up U2F security key x

o Setup is complete for this U2F security key.
Tapping this U2F security key is now required during sign-in.

5 ==

You could manage your security key by clicking the button "Manage MFA device".
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5 HOTP Applications

5.1 Overview and Functionality

The iShield Key Pro also offers one HMAC-based One Time Password slot. We recommend using HOTP for two-
factor authentication on a service that does not support WebAuthn compliant FID02 security keys. The iShield Key
Pro implements touch-triggered HOTP generation with the RFC 4226 algorithm by IETF. Network applications such
as VPN access often use this standard algorithm. The HOTP functionality of the iShield Key Pro can be used without
any installation effort. It is as simple as plug and play.

In section 5.1.1, the registration of your iShield Key Pro with a service is explained, section 5.1.2 gives details on
the computation of a HOTP, section 5.1.3 describes the process of password generation and authentication and
section 5.1.4 illustrates the resynchronization of the hardware authenticator and server.

Please note that this section is not compatible with the iShield Key FIDO2.

5.1.1 Registration

For symmetric generation of one-time passwords of the iShield Key Pro and service for which you want to register
a second factor, the secret key and initial counter value is shared. The service provides the secret key and initial
counter value and you can use the iKMcli to configure your iShield Key Pro HOTP applet accordingly as follows:

ikMcli hotp --set-key <key> --pin <pin>_ i
ikKMc1i hotp --set-counter <counter> --pin <pin>

Moreover, you can choose if you want to generate passwords of six or eight digits:
ikKMc1i hotp --set-otp-length <length>
See section 3.1.2 for usage instruction for the iKMcli and all supported HOTP operations. We recommend changing

the factory default PIN before registering your iShield Key Pro with a service. The default PIN is 1234. Please note
that the PIN cannot be unblocked once you entered it incorrectly 10 times in a row.

5.1.2 HOTP Computation

Input: Secret Key, Counter Af—
O =Ws|4|7]3]2[7
l ° EH 1. Given a secret key and counter value as input

HOTP Computation

values, the iShield Key Pro computes a new HOTP
using the HMAC based RFC k226 algorithm

2. iShield Key Pro counter is incremented — the
next HOTP will be computed given this new input
RFC 4226 Algorithm e value for the counter

eED ¢ :]

iShield Key Pro

HOTP
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The iShield Key Pro implements secret key and counter-based HOTP generation using the HMAC based RFC 4226
algorithm. Given a secret key and counter value as input values, the iShield Key Pro computes a six or eight digit
human-readable password. The counter is a moving factor. After computation of a new HOTP, the counter is
incremented and the next HOTP is computed based on the incremented counter. Therefore, each counter value
enters only once the computation of a password.

5.1.3 Password Generation and Authentication

iShield Key Pro HOTP Validator
. a + E‘E o HOTP Generation and
ah 4_°_ =ou) <_—| Authentication
5]4]7(3(2(3 S
\ o~DOEBEH o momERH
I I ry 1. iShield Key Pro security key is registered
2. User touches iShield Key Pro
3. New HOTP is generated and iShield Key Pro
counter is incremented
° 4. User enters login data with HOTP

5_Verify HOTP with Server

6. Authentication granted
7. Server counter is incremented

HOTP computation (3.} is illustrated in more detail on previous slide

After you registered your iShield Key Pro with a service that uses HOTP, no connection is required to generate
coinciding series of passwords. This is due to deterministic nature of the HOTP algorithm and the shared secret
key and counter between token and server. The token generates a new password on touch and increments the
counter. When the user now authenticates to the service, the password is compared to the password generated
by the server. On successful authentication, also the counter of the server is incremented.

The step 3 of the HOTP computation is illustrated in more detail in the previous section.
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5.1.4 Counter Resynchronization

HOTP Counter
iShield FIDO2 Key HOTP Validator Resynchronization

[ = O]
omo i =P 0 > =00
1. iShield FIDO2 and server counters are in sync

2. User repeatedly touches iShield FIDO2 key and
@: @ generates passwords — the counter is
incremented on every touch
3. Usertries to authenticate with last generated
HOTP, so server generates the next HOTP and
compares the passwords - no authentication

attempt was made with several passwords, hence
EH H verification fails
L4 Server generates further HOTP with counter
increments until verification succeeds or
tolerance is exceeded
5. Verification succeeded with a counter

increment — only now the server counter is
. incremented and resynchronized with the iShield
> FIDO2 counter
. .
"

51417(31217] #

5[al7]3[20 @ coaees

—O0— I —

It can happen that the token and server counter loose synchronization. For instance, if the user touches the
token, generates a new password but does not authenticate to the associated service with it. In order to avoid
unsuccessful authentication attempts, configure the look-ahead parameter on the server. This parameter defines
how many counter increments are considered for password comparison, so some sort of tolerance is allowed.
Successful authentication resynchronizes the counters of the generator and server.

*

y W %
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6 PIV Applications

In this part of the guide, you will learn how to use your Swissbit iShield Key Pro as a personal identification and
verification (PIV) device on Windows. The iShield Key Pro key with PIV applet provides different slots to store and
provide various certificates for different use-cases. This guide uses the OpenSC Minidriver complemented with
the Swissbit iShield PIV module to provision the smartcard with these certificates. We will show how to generate
and use these in the following sections.

Please note that this section is not compatible with the iShield Key FIDO2.

6.1 Overview Use Cases

Local Windows Account Active Directory Domain Account
Windows Logon Use iShield Key Pro to logon to a local windows Use iShield Key Pro to logon to any Workstation
user account. in a Domain setup. The certificate on the

smartcard store account information. A user
only has to connect it to the PCand provide
their smartcard PIN.

Bitlocker Encrypt data drives with self-signed certificates. | Encrypt data drives with domain CA issued
certificates.

For these PIV use-cases, we need to differentiate between two configurations of the Windows environment:

o lLocal Account: Where one or multiple accounts reside in one PC. They do not belong to a domain, where
a central organization would manage them. This configuration typically occurs in home PCs.

e Active Directory Domain Accounts: A central domain server manages machines, users, printers and
others within this domain network. This configuration is useful for large structures like companies to
manage employee accounts/machines.

Both configurations are able to host all PIV use-cases, albeit with some differences regarding setup or usage. This
guide will in general target information regarding the local account scenario first and continue with setup
instructions for active directory. Furthermore, it is possible to have one PC with local and active directory domain
accounts on it. This might result in some incompatibility between the different use-cases. For more information,
have a look at the respective instructions in this guide.
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e| | XD

Lt
o

With the iShield Pro Key you implement a more secure logon based on a PKI hardware token, instead of a
password. Your windows user account is configured to trust the certificate on your smartcard. Moreover, you only
need to plug in your iShield Pro Key and provide a short PIN, which not only is more secure than passwords but
also more convenient.

¢l E

iShield Key Pro

suwlissbit®

Windows Logon via
iShield Key Pro

1. Get certificates from iShield Key Pro

2. Present certificates applicable for logon to user
3. User selects logon certificate

L_ Request User PIN

5_ User authenticates via PIN and logon request is
sent to iShield Key Pro

6. Logon reqguest is signed with private key

7. Signed authentication request VERB

8. Verify signature and certificate chain with
public key

9. Account access is granted / denied

For exact instructions on how to setup and use the iShield Pro Key for logon purposes within a domain, have a
look at section 6.7.
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6.1.2 Bitlocker

Drive Encryption with
A Bitlocker

L Encryption:

®
XD
®

1. Encrypt drive with public key from iShield Key
Pro - Drive is locked after being unplugged

””””””””””””””””””””””””””””””””””””””””””””””””””””””””””””””” Decryption:
2. User authenticates via PIN
3. Decrypt drive with private key stored on iShield
Key Pro - Drive is unlocked until it is unplugged

Bitlocker is a Microsoft tool that is used to encrypt and decrypt data drives. This targets drives, that are installed
in a PC internally or external drives, which typically connect to various different machines. Whenever you are
storing data on the drive, Bitlocker encrypts it with a pre-defined certificate. As soon as a Bitlocker session
terminates (for example by unplugging the external USB drive or powering down a PC) the data is encrypted and
not readable anymore. To get access to the device again, you will need to provide the decryption information. In
the most common case, they exist in the form of a PIN or key you will need to enter when you insert the drive or
start your PC.

For higher security, you can use the iShield Key Pro to store the required certificates and decryption information.
Whenever a user wants to access data on said medium, they need to insert the smartcard with the corresponding
encryption certificate and provide its PIN. This allows for higher security of the data: To access them, you will
need to provide the iShield Key Pro with the certificates and enter its PIN.

Note that the Windows 0S (C:) partition is not a data drive. Bitlocker is not set up to use a smartcard to encrypt
it but has other limited configurations for this.

For exact instructions on how to setup and use the iShield Key Pro for Bitlocker within a domain, have a look at
section 6.6. If you want to use it on a local account, continue in section 6.5.

6.1.3 Active Directory

Microsoft sells components for Active Directories (AD), which is a domain infrastructure for which we will explain
setup and compatibility in parts of the remainder of this PIV guide. This Active Directory Domain Structure consists
of several components:

¢ Domain Server(s): Management utilities, to configure all components within this structure. Among many
others, this include users, workstations, server components and (important for PIV) certificates.

o Workstations: Multiple Client PCs on which users can logon to their accounts. These receive their
configuration by the Domain Server(s).
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For AD use-cases, this guide assumes that you have already setup the required components.

6.2 Underlying Components

6.2.1 Token Provisioning and Usage on
Windows

The Windows [Inbox smartcard minidriver
supports PIV smartcards but only read access is
possible. The minidriver is sufficient for usage of
PIV functionality of the iShield Key Pro but card
administration is not possible. Once your PIV card
is provisioned for your use cases i.e. all required
certificates are generated on the smartcard, you
can use the Windows PIV driver to sign or decrypt
with your iShield Key Pro.

For write access, that is to say for provisioning
your card, the installation of the OpensC
Minidriver and configuration to use the Swissbit
iShield PIV Module for card administration is
required.

6.2.2 Authentication

Smartcard-aware Cryptographic Applications (using CryptoAPI)

\ Read-Only Access

Microsoft Base CSP
) ) 3
P
\

Windows Inbox Smartcard

Minidriver for PIV Smartcards CpeasChliniduvey

iShield PIV Module

I Read / Write Access ,

WinSCard CryptoAPI
iShield Key Pro with PIV Applet

The iShield Key Pro has three passwords that are required for management operations and usage. The PIN is
required for normal usage of the token, i.e. for private key operation such as signing and decryption. The PIN is
of course also required for changing the PIN and for setting the PIN retries. The PUK can be used to unblock the
PIN. The management key is necessary to authenticate for performing administrative operations. Examples for
operations for which you need to authenticate as administrator are key import or generate deleting or importing

certificates or generally writing PIV data to the card.

6.2.3 Certificate Slots

The PIV applet stores certificates and the corresponding
public private key pairs in slots — one slot can hold one

PIV Applet

certificate. The iShield Key Pro holds four standard PIV ?@: Slot op [ == User Authentication

slots 9A, 9C, 9D and 9E and 20 further retired slots 82 -
95. Each standard PIV slot has an intended purpose, the
retired certificate slots are typically used for expired
certificates but can be used for signing or decryption like

the certificates any other slots.

The certificate in slot 9A is usually used for user
authentication. You can use this slot for your certificate

e.g. Smartcard Logon

)
St Slot oc | =P Digital Signature

Encryption
=== e.g. Drive Encryption
using Bitlocker

&= 3

N Slot 9D

for smartcard Windows logon; see section 6.1.1 for the @ — Card Authentication

use case. The certificate in slot 9C is for digital signature
e.g. for email signing. The private key of the slot is
according to the standard generated with special PIN
policy. As per the standard, the PIN is require for each
private key operation. The certificate in slot 9D is used
for encryption for confidentiality. A use case, for which
you would want to use this slot, is drive encryption using
Bitlocker; see section 6.5. Slot 9E again has a special PIN
policy. The PIN is never required for private
operations, so the certificate in this slot is for card
authentication. A typical use case is access to building.

key

X e.g. Physical Access

&= &3

N Slot 82

==Jp Retired Certificates 1 — 20

=S

N Slot 95

Private Key Certificate
L)
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When provisioning the iShield Key Pro using the OpenSC Minidriver, supplemented with the iShield PIV Module
for PIV administration, the certificates are generated in the next free slot with standard PIN policy: The first
certificate is stored in slot 9A, the next one in slot 9D, followed by the retired slots in order.

6.3 Requirements
For now, Swissbit has tested the following systems and applications with Swissbit iShield Key Pro for PIV.

e PCOperating System: Windows 10 Pro; Home editions do not ship with Bitlocker or Domain Account
support. The Instructions should be similar in Windows 7/8/11.

o Server Infrastructure: Windows Server 2019; for setup with Active Directory. Setup instructions might
work differently for other Server versions.

6.4 G@etting started with PIV on iShield Key Pro
Please download the installation package from the Swissbit iShield Key Pro landing page.

6.4.1 PIV Installation Package
In the installation package, you should find the following tools:

e |— UserManual.pdf This guide
|— iKMcli.exe iShield Key Manager command line tool
e |— winéylishield-piv-module

| F—bin

e | | F—ishield_piv_module.dll PIV module
e | | L— vcruntimeigo.dil, msvcpigo.dil, etc.  Required system runtime libraries
e | L—PIv-ll.profile OpenSC PIV profile

e L — win32/ishield-piv-module

. — bin

. |  p—ishield_piv_module.dIl PIV module
. | L— vcruntimeigo.dll, msvepigo.dll, etc. Required system runtime libraries
° L— PIV-Il.profile OpenSC PIV profile

6.4.2 Installation of the OpenSC Minidriver and iShield PIV Module

Within the following setup instructions, Windows requires you for some actions to install a vendor specific
minidriver. For the iShield Key Pro, this comes in the form of the OpenSC Minidriver, which is extended by the
Swissbit iShield PIV Module.

This step is always required for operations, where Windows is writing certificates to the smart card. In case all
necessary certificates are already present on the iShield Key Pro, the pre-installed default Windows Minidriver is
sufficient. All setup instructions will hint to whether this vendor specific minidriver is required.

The OpenSC Minidriver in combination with the iShield PIV module supports all use-cases the same way, the in-
built Windows Smartcard Minidriver does.

Install OpenSC
e From the Swissbit OpenSC GitHub' repository, download the latest release of OpenSC.

" https://github.com/swissbit-eis/OpenSC
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e Run the installer for your operating system. Make sure to select “Complete" installation
e Copy the .profile file to the profiles/directory in your OpenSC installation folder (Unless you have
changed it, by default the OpenSC installation folder is in C/Program Files/OpensSC Project/OpenSc))

Create Management Key configuration
OpenSC expects a text file containing the management key in the following format:

XX2 XX XX XX XX XX XX XX XX XX XX XX XX XX XX XX XX XX XX XX XX XX XX XX

e.g. 01:02:03:04:05:06.:07:08:01:02:03:04.:05:06.:07:08:01:02:03.:04.:05:06.:07:08 for the default management
key. An environment variable PIV_EXT_AUTH_KEY must point to this text file. Do not forget to update this
file, whenever you are assigning a new management key.

Configure Environment Variables:
Search for “Environment Variables" in the start menu and click £dit Environment Variables

e Add the environment variable "PIV_EXT_AUTH_KEY" pointing to the file with the management key.
e Edit the environment variable “PATH", add the path to the OpenSC foo/s directory to the entries

Include iShield PIV Module
Adjust the OpenSC configuration to use an external PKCS#15 Init module for PIV:

e Copy the iShield PIV module ishield_piv_module.d/lfile to this PC (e.g. into the OpenSC installation
folder)

e Make sure you have installed the “Microsoft Visual C++ Redistributable for Visual Studio 2015" or newer
from the official Microsoft webpage? or place the required system runtime libraries from the installation
package next to the iShield PIV module

e Modify the configuration file opensc.confto include the module by adding the following information.
Make sure to replace the module path with the location to where you have copied the .dll-file:

2 https://visualstudio.microsoft.com/downloads/#microsoft-visual-c-redistributable-for-visual-studio-2022
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app default {

framework pkcsl5 {
pkcs15init PIV-II {
module = "<ishield_piv_module_path>";

card_atr 3b:97:11:81:21:75:69:53:68:69:65:6c:64:05 {
! driver = "PIV-II";

I & = | OpensC - O
Home Share View
[T Preview pane & Extralarge icons [&| Large icons I [F]~ [ ttem check boxes 17
&2 Medium icons 5 Small icons - - File name extensions
Navigation [TH petails pane g

[
o Sort Hid lected Opti
pane- Epeals |7 o B O icdenitems e |
Panes Layout Current view Show/hide
<« =2 v 4 >IThisPC » Local Disk (C) » Program Files » OpenSC Project » OpenSC I v O £ Search OpenSC
Mame Date modified Type Size
v 3k Quick access
I Deskt » e 02/02/2023 11:03 File folder
eskto
P minidriver 02/02/2023 11:03 File folder
f Downloads b pkestl 'j otoond
%] Documents * profiles . operjlsc otepa .
=/ Pictures » tools File dEd|; Flormzt View Help
. ER . app default
J‘s Music - g ishield_piv_med # debug = 3;
OpenSC g key.tet # debug_file = opensc-debug.txt;
r J EEEEE ramewor cs
B videos = i f k pkcsls
# use_file_caching = public;
@ OneDrive pkcsl5init PIV-IT {
L ITNE-NE I - \Program Files\OpenSC Project\OpenSC\ishield piv_module.dl11j
»> O3 This PC 3
b Network card_atr 3b:97:11:81:21:75:69:53:68:69:65:6C:64:05 {
driver = "PIV-II";
1
}
ditems  1itern selected 336 bytes

Ln7, Col 85 100%  Unix (LF) UTF-8

Restart your PC now!
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6.4.3 Preparation of the iShield Key Pro

It is highly recommended to change the PIN, PUK and management key before using the iShield Key Pro. For this
purpose, you can use the iKMcli. Please plug in your iShield Key Pro now and execute the following commands:

ikKMcli piv --change-pin <new pin> --pin <pin>
iKMcTi piv --change-puk <new puk> --puk <puk>
ikKMcli piv --set-management-key <new key> --management-key <key>

Remember to adjust the management key also in your key file from 4.1.2.

The factory default for the PIN is 123456, the default PUK is 12345678 and the management key is
010203040506070801020304050607080102030405060708.

6.4.4 Reset the iShield Key Pro

If you want to reset the PIV applet on your iShield Key Pro, that is to say erase all PIV data and restore the default
settings, follow these steps:

Block your PIN and PUK by authenticating with wrong passwords, e.g.

ikKMc1i piv --change-pin 123456 --pin 111111
ikKMc1i piv --change-puk 12345678 --puk 11111111

Once you blocked your PIN and PUK, you can reset the iShield Key Pro by

ikKMcli piv --reset
Set a new card holder unique identifier and card capability container by
iKMcli piv --set-chuid

ikKMcli piv --set-ccc

Prepare your iShield Key Pro for usage and set a new PIN, PUK and management key as in section 6.4.3
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6.5 Use Case: Local Account Bitlocker

In this scenario on the local account, the Bitlocker certificate is self-signed on the local PC, which requires a
different setup procedure, than in other Bitlocker scenarios. This guide targets private customers that want to
use the Bitlocker functionality on their home devices.

6.5.1 Setup Process

To setup Bitlocker with iShield Key Pro you will need to write a certificate to the iShield Key Pro. We will use the
Microsoft in-built EFS certificate utility, which handles certificate generation and storage on the smartcard
automatically. You will also need to modify the Bitlocker configuration to accept these certificates.

This requires you to install the OpenSC Minidriver and the iShield PIV Module as described in section 6.4.2

Allow self-signed certificates on Windows PC

This step is necessary for development purposes. It configures windows to allow using self-signed certificates for
Bitlocker. You can generate such certificates yourself and do not need to request them from an official certificate
authority. If possible, we recommend official certificates for high security purposes, but this guide will not go
into details on them.

Open the Registry editor by searching for regedit in Windows Home menu.

e Locate ComputerlHKEY_LOCAL_MACHINEISOFTWAREIPoliciesIMicrosoftIFVE (If any of these directories does
not exist do a right-click, New, Key)
e (reate (if not existent) the Key selfsignedcertificates (DWORD 32 bit) and set its value to 1.

[ Registry Editor = O X
File Edit View Favorites Help
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\FVE

Microsoft A || Name Type Data

Mozilla ab] (Default) REG_SZ (value not set)
gs&c REG_DWORD 0x00000001 (1)
OpenSC Project

OpenSSH

Oracle

Partner

v Policies
v Microsoft
' Cryptography
PeerDist
Peernet
SystemCertifica
TPM
Windows
Windows Advar
Windows Defen
Windows NT
RegisteredApplication

Windows
WOW6432Node
QVETEM

Generate EFS Certificate

Within this step, you will use a windows tool to generate an EFS-certificate on the iShield Key Pro. If such a
certificate (or any Bitlocker compatible certificate) is already present, you can skip this step.

Launch a control panel:
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e Search for "certificates" and click Manage file encryption certificates

X
@1 Encrypting File System

Manage your file encryption certificates

Encrypting File System (EFS) lets you store information on your hard disk in an
encrypted format and choose which users can access it. Encryption helps keep your
files safe from prying eyes.

To access your encrypted files, you'll need an encryption certificate and a decryption
key on your PC or smart card. You can use this tool to update files you've already
encrypted to a different certificate and key.

‘ ] Cancel

e (lick through the wizard: Next > "M(reate a new certificate" > Next
X

€ @u Encrypting File System
Select or create a file encryption certificate

Certificates help verify your identity so that when you encrypt or decrypt a file, we know it's

really you. If you've already encrypted some files, you can update them to use this
certificate.

Use this certificate
If you are using a smart card, selectthe certificate on the smart card.

Certificate details:

Your computer does not currently have a file encryption ce View certificate

Select certificate

@ Create a new certificate

Next Cancel
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e "M Make a new self-signed certificate and store it on my smart card" > Next

X
& . Encrypting File System

Create a certificate

(O Make a new self-signed certificate and store it an my computer
Create a certificate to help keep yourfiles safe if your PC is lost

(® Make a new self-signed certificate and store it on my smart card

Create a certificate to help keep yourfiles safe if your PC is lost When accessing
files encrypted with this cerificate you'll need to use your smart card. Insert your smart

e Emr dain i

Get a certificate from my domain's cerification authority

Mext Cancel

e Provide the PIN for your iShield Key Pro

Click cancel/ (You do not need to finish the procedure since by now, the utility has already written the
certificate to the Smartcard).

Allow EFS Certificates for Bitlocker

In this section, you will configure your local Bitlocker setup to accept certificates with the 0ID, which was
originally assigned to the Microsoft File Encryption Certificates.

In a PowerShell, execute certutil -scinfo:

e You will be prompted for your smartcards PIN multiple times
After execution you will find Application[0] = ..." in the output. Copy the 0/D after the '='sign

Application[@]
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Navigate to Local Computer Policy > Computer (onfiguration > Administrative Templates > Windows
Components > Bitlocker Drive Encryption
Edit the setting "Validate smart card certificate usage rule compliance"

=/ Local Group Policy Editor m} *
File Action View Help
e 2H = E=T
15[ Local Computer Policy BitLocker Drive Encryption
v i Computer Configuration i
=] Software Settings Validate smart ca.rd certificate Setting State
“| Windows Settings usage rule compliance _| Fixed Data Drives
v [ Administrative Templates Edit policy setting —| Operating System Drives
| Control Panel _| Removable Data Drives
| Network Requirements: i=| Store BitLocker recovery information in Active Directory Do.. Mot config
“| Printers At least Windows Server 2008 R2 Choose default folder for recovery password Not config|
| Server or Windows 7 |=| Choose how users can recover Bitlocker-protected drives (.. Mot config
_| Start Menu and Taskbar Description: Disable new DMA devices when this computer is locked Not config
_| System This policy setting allows you to i=| Choose drive encryption method and cipher strength (Wind... Mot config

~ [ WindnwanmEnnEnts

| ActiveX Installer Service

| Add features to Windows 10

| App Package Deployment

| App Privacy

| App runtime

| Application Compatibility

| AutoPlay Policies

| Biometrics

| BitLocker Drive Encryption
= Gamera

| Cloud Content

| Connect

associate an object identifier from
a smart card certificate to a
BitLocker-protected drive. This
policy setting is applied when you
turn on BitLocker.

The object identifier is specified in
the enhanced key usage (EKU) of a
certificate. BitLocker can identify
which certificates may be used to
authenticate a user certificate to a
BitLocker-protected drive by
matching the object identifier in
the certificate with the object
identifier that is defined by this

|&=| Prevent memory overwrite on restart

% Validate smart card certificate usage rule compliance Mot cenfig

Choose drive encryption method and cipher strength (Wind... Mot config
Choose drive encryption method and cipher strength (Wind... Mot config
Provide the unique identifiers for your organization

Mot config
Mot config

\wExten d‘e:lX.Sta ndard

Check & Fnabled

Paste the previously copied 0ID underneath Object identifier

o Then click 0K
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& Validate smart card certificate usage rule compliance [m| X

E} Validate smart card certificate usage rule compliance Frzfrm S

(O Net Configured Comment:

() Disabled
Supported on: [ At |east Windows Server 2008 R2 or Windows 7
Options: Help:
Object identifier: This policy setting allows you to associate an object identifier -
from a smart card certificate te a BitLocker-protected drive. This
I1.3.6.1.4.1.311‘1D.3.4J I policy setting is applied when you turn on BitLocker.

The ohject identifier is specified in the enhanced key usage (EKU)
of a certificate. BitLocker can identify which certificates may be
used to authenticate a user certificate to a BitLocker-protected
drive by matching the ohject identifier in the certificate with the
object identifier that is defined by this policy setting.

Default object identifier is 1.3.6.1.4.1.311.67.1.1

Mote: Bitlocker does not require that a certificate have an EKU
attribute, but if one is configured for the certificate it must be set
to an object identifier (OID) that matches the OID configured for
BitLocker.

If you enable this policy setting, the object identifier specified in
the "Object identifier” box must match the object identifier in
the smart card certificate.

Enable Bitlocker for one storage medium

After this step, you have prepared an external flash drive or (internal) data-disk for Bitlocker. All the present
data will be encrypted retroactively and all future data stored there will be encrypted. Note that this does not
work with boot drives, but only data disks.

Note: For this step, you do not need to install the OpenSC Minidriver and iShield PIV module anymore. As soon as
there is a valid certificate on the iShield Key Pro, the pre-installed Windows tools work by themselves.

Insert the device you want to encrypt in your PC and open it in the Windows Explorer.

e Right-click on the drive and select Turn on BitLocker.

Page 54 of 69



sulissbit®

Open
Open in new window
Pin to Quick access
Open AutoPlay...

Ea Scan with Microsoft Defender.., is PC

Give access to )
Include in library >
Docu Pin to Start

it

Format...

Pictul Eject

Cut
Copy

Create shortcut

Rename

USB [ Properties

.y 743 GE free of 7,46 GB

e (heck Use my smart card to unlock the drive and click Next.
%&l BitLocker Drive Encryption (E:)

Choose how you want to unlock this drive

[ Use a password to unlock the drive

Passwords should contain uppercase and lowercase letters, numbers, spaces, and symbols.
Enter your password

Beenter your password

Use my smart card to unlock the drive

You'll need to insert your smart card. The smart card PIN will be required when you unlock the drive.

MNext Cancel

e Store your recovery key in some secure place. In case you were to lose your iShield Key Pro in the
future, you can still recover your encrypted drive. Click Next.

e For the next options, you can chose whichever you want. Finally click Start encrypting. Depending on
the options you have chosen, this might take a while.

The drive and smartcard have now been prepared to work with Bitlocker on any Windows 10 Pro PC.
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BitLocker Drive Encryption *

fi Encryption of E: is complete.
¥

Manage Bitl ocker

Close

6.5.2

Use it to encrypt a Drive

As soon as the iShield Key Pro and external drive are prepared, the default Windows PIV driver is sufficient for
usage with Bitlocker. You will not need to install the OpenSC Minidriver or iShield PIV module in this case.

Insert your drive. You should see a message "This drive is BitLocker-protected".

Access the drive via the Explorer. A prompt for your smart card (iShield Key Pro) or your recovery key will
appear.

Select the "smart card" option and provide your smart card PIN.

You will find the drive unlocked and usable until you unplug and reinsert it
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6.6 Use Case: Active Directory Bitlocker

In this scenario, the PC, on which Bitlocker is used, is a workstation within an active directory domain. The
domain server will manage all the domain information. Upon request, the certificate authority on the domain
server will issue and sign the used certificate. This is ideal for companies, in which the AD infrastructure already
exists. You can increase your data security by following the next steps.

This guide expects a working AD setup.

6.6.1 Setup on Server

This section explains the necessary steps to configure a Microsoft Active Directory Domain Server for this use case.
These instructions target the IT Administrator of a domain and you cannot conduct those on a personal computer
or domain workstation.

Requirements beforehand

All users, that want to self-enroll certificates for Bitlocker, need an email address assigned to them in the user
management tool.

In the Server Manager:

e (o to Jools > Active Directory Users and Computers
e Inyour domain go to Users and right click the user
o C(lick Properties > General Make sure an email address is assigned to them

Setup Bitlocker Template
On the AD-ROOT-Server, open the Server Manager.

1. In the top right go to 7oo/s > Certification Authority

2. In certsrv expand the server name
3. Right click Certificate Templates > Manage

Setup the Bitlocker Template:

4. In Certificate Templates Console right click Smartcard User > Duplicate Template and adjust the

Properties of each of the tabs as follows:

] Active Directory Users and Computers - [m] x O
File Action View Help File Action View Help
— — — Test User Properties. ? X
=2 |2H 0| XEEE R B ETER e am ¥ ol
= = = Member OF Diakin Environment Sessions
Active Directory Users and Com Active Directory Users and C|
=T Y Name Type Description = v Remote control Remote Deskop Services Profile COM- Description
| Saved Queries | Saved Queries
&, Administrator User Built-in account for ad. General | Address | Account | Profle | Telephones | Organization Built-in account for ad.
v Sb‘f:“f::_“d”’"a‘”“'" 2 Allowed RODC Password Replication Group Security Group... Members in this group c... v E Sb‘f:?‘f“d”ma‘”“m roup... Members i this group c...
- (”' " . 2, Cert Publishers Security Group... Members of this group .. - E“' " . D e roup.. Members of this group ..
" Computers | Computers D
| Domai Controllers %EInneab\eDnmam Controllers Security Group... Members of this group t. | Domai Controller roup... Memmbers of this group t
| ForeignSecurityPrincipal | -t Denied RODC Password Replication Group Security Group... Members in this group c...  ForeignSecurityPrinci roup... Members in this group c..
| Managed Service Accou £ DnsAdmins o Security Group... DNS Administrators Gre.. | Managed Service Ac First name Initials: roup.. DNS Administrators Gro.
Users 2 DnsUpdateProxy Py Security Group... DN clients who are per.. Users L 0 | o DN clients who are per.
=] =] name: ser
2 Domain Admins Add to a group. Security Group... Designated administrato... roup.. Designated administrato...
2, Dornain Compute Disable Account Security Group... Al workstations and ser. Display name [Test User | roup... All workstations and ser.
B, Domain Controlle  Reset Password... Security Group... Al domain controllers i.. 5 roup.. Alldomain controllers ..
£ Domain Guests — Security Group... Al domain guests ssciiption [ | roup... Al domain guests
2 Domain Users Open Home Page Security Group... All domain users Office [ ] roup... All demain users
2 Enterprise Admin: Security Group... Designated administrato. roup... Designated administrato,
9 Enterprise Key Ad SER Security Group... Members of this group .. 2. roup... Members of this group ..
B EnterpriseRead-0 All Tasks Security Group... Members of this group .. Telephone number. Other. roup... Members of this group ..
8, Group Policy Crez o Security Group... Members in this group ¢ I pE— [ ———— 11 roup... Members in this group ¢
2 Guest User Built-in account for gue.. Built-in account fer gue...
£, Key Admins Delete Security Group... Members of this group ... Web page: Cher. roup... Members of this group ...
2, protected Users Rename Security Group... Members of this group .. roup... Members of this group ..
HLRAS and A5 Serve o Security Group... Servers in this group can roup... Servers in this group can
2 Read-only Domai : s Security Group... Members of this group ... roup... Members of this group ...
2 Schema Admins Help Security Group... Designated administrato... roup... Designated administrato...
b Y rest user User
Opens the properties dizlog box for the current selection.
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o General: Rename template

Properties of New Template X
Subject Name Server lssuance Reguirements
Superseded Templates Extensions Security

Compatibilty General  Request Handling  Cryptography  Key Attestation
Template display name:
ISmartcard User Bitlocker I |

Template name:
|Smartcard UserBitlocker

Validity period: Renewal period:

years w EI weeks w

Publish certficate in Active Directory

[[] Do net automatically reenroll i a duplicate certfficate exists in Active
Directory

ox o | [ e

o Request Handling: Select purpose Encryption

Properties of New Template X
Subject Name Server lssuance Requirements
Superseded Templates Extensions Security

Compatibilty General Request Handling  Cryptography — Key Attestation

Purpose:
Signature and encryption
Signature and smartcard logon
AITTIVE SU0[ECT & encTypn
[ Mllow private key to be exported

Renew with the same key (7)
Far automatic renewal of smart card cenificates, use the existing key f a
new key cannot be created ()
Do the following when the subject is enrolled and when the private key
associated with this certificate is used:
(®) Enroll subject without requiing any user input
(Z) Prompt the user during enroliment
O Prompt the user during enroliment and require user input when the
private key is used

* Control is disabled due to compatibility settings.

ox | [ ren
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o (Cryptography: Requests must use one of the following providers: Microsoft Base Smart Card

Crypto Provider

Properties of New Template ¥
Subject Name Server Issuance Requirements
Superseded Templates Extensions Security

Compatibility ~General ~Reguest Handling Cryptography  Key Attestation

Pravider Categany: Legacy Cryptographic Service Provider
Ailgorithm name: Determined by CSP hd

Choose which cryptographic providers can be used for requests
Requests can use any provider available on the sublect's computer
(®) Requests must use one of the following providers:

Providers:

|l Microsoft Base Smart Card Crvoto Provider {‘\
[IMicroscft DH SChannel Cryptographic Provider

[IMicroscft Enhanced Cryptographic Provider w1.0

[Microsoft Enhanced DSS and Diffie-Hellman Cryptographic Pr

[ IMicroscft Enhanced RSA and AES Cryptographic Provider v %

Reguest hash: Determined by CSP

Use altemate signature format

ox R

o Extensions:

= Application Policies: Edit... -> - Remove all;

es of New Template

Subject Name Server lssuance Requirements | Subject Name Server lssuance Requirements

Properties of New Template X | Properti
|

Compatibilty General Request Handling Cryptography — Key Attestation Compati

Superseded Templates Extensions Security Suj

To modify an extension, select it, and then click Edit. | Tomo

Extensions included in this template:
[E Application Policies
D Basic Constraints
DCert'rﬁcate Template Information
Dlssuance Paolicies

Edit Application Policies Extension *

An application policy defines how a certificate can be
used.

Smart Card Logon

E Key Usage

Description of ication Policies: Descri add... Edit...
Secure Email | |Secun k
Client Authentication | |Client| [T make this extension critical

Smart Card Logon | Smart

ox ] |

oK Cancel

hilitw  General Reouest Handling  Crvntoaranhy  Kew Attestation

fity

QK Cancel Apply

Help
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Add... -> New... -> Name: your choice (e.g. “Bitlocker network unlock"), Object
identifier: 1.3.6.1.4.1.311.67.1.1 (default in Bitlocker policies, must correspond to settings

on client);

| Properties of New Template > | Properties of New Template | Properties of New Template = |
| |
| Subject Name Server Issuance Requirements | Subject Name Server Issuance Requirements Subject Name Server Issuance Requirements
Ci il General  Beouest Handling  Ci b Kew ion Ci il General  Reauest Handlina  Ci by Kew ion Ci il General  Reauest Handlina  Ci by Kew ion
Su Edit Application Policies Extension > [y ol o e 5 ol o b i i — L“"—|
Add Application Policy X dd Applica Yolicy X
Tomo An application policy defines how & certificate can be
used. + | An application policy (called enhanced key usage in Windows 2000) An application policy (called enhanced key usage in Windows 2000) |
| Beng | | defines how a certificate can be used. Select the application policy required | | | defines how a certfficate can be used. Select the application policy required
I for valid signatures of certificates issued by this template For valid signatures of issued by this template
| Elrg Application palides: | | L .
| |Eles | | | Mew Application Policy X
| DCE | Application policies: |
= || Ay Pumpose ~| ||| Typeaname forthe new application policy. and if necessary change the
&l || |Attestation Idertity Key Certficate object identifier
|| |Cetficate Request Agert 3.
Client Authenticati
C:I:da Signing feation I Bitlocker network unlock] I |
— — | CTL Usage |
| ) | ggr;t;\ Higshts Email sl | | (Object identffier: |
| 1 U1 | Disaloneg et et repleation | I 138141316711 | |||
+ Descri | Document Encryption |
| BitlocH Ed... L T [ Document Signing
Domain N 5 DHS) S Trust | |
| [ Make this extension critical | D::;:% g;jea Gy;?afw ) Server Tru l Cancel
| . |
. MNew. Mew
. - > |
| ! Cancel ! OK Cancel
oK Cancel
\ \ [
| | |
| oK Cancel Apply Help | oK Cancel Apply Help | oK Cancel Apply Help
| | | |
= Key Usages:
Allow key exchange only with key extension
Make this extension critical extension.
Properties of New Template X | Pro le
. . i , :
Subject Name Server Issuance Requirements | Subject Name Server Issuance Requirements
Compatibilty General Request Handling  Cryptography = Key Attestation | Compatibilty General Request Handling = Cryptography = Key Attestation
Superseded Templates Extensions Security < dad Tamal Extensi Qanuh
| | Edit Key Usage Extension X
To modify an extension, select it, and then click Edit. |
| | Specify the required signature and security options for a key usage
Extensions included in this template: | | extension.
E|Application Policies | Signature
Basic Constraints ‘ Digtal signatire
DCeft'rficate Template Information ) _ )
" | Signature is proof of origin {nonrepudiation)
D Issuance Policies |
Key Usage | Certificate signing
|
| CRL signing
' 2 -
1 | : :
= k | (®) Allow key exchange only with key encryption {key encipherment)
Description of Key Usage: # [] Allow encryption of user data
Allow key exchange only with key encryption Y
Critical extension. i 3
| -
| Make this extension critical |
|
; oK Cancel
|
| 1T
OK Apply Help OK Cancel Apply Help

Page 60 of 69



o

Security: Authenticated Users > allow Read and Enrol/

Properties of New Template x

Subject Name Server Issuance Requirements
Compatibilty General Request Handling Cryptography = Key Attestation
Superseded Templates Extensions Security

GI’OIJP or user names:

B2 Authenticated Users

a Administratar

S8 Domain Admins (SB\Domain Admins)

2 Enterprise Admins (5B"\Enterprise Admins)

Add... Remaove

[w )

Permissions for Authenticated Users eny

Full Control
s
Wirite
[E=i
Autoenrall

ooooo

For special permissions or advanced settings, click Advanced
Advanced.

ox | [

o

Subject Name: Supply in request -> Accept warning

Smartcard User Bitlocker Properties 7 *

General Compatibiity Request Handling Cryptography  Key Attestation
Superseded Templates Extensions Security Server
Subject Name lssuance Requirements

upply in the request

Use subject information from existing certificates for autoenrollment
renewal requests )

() Build from this Active Directary information

Select this option to enforce consistency among subject names and to
simplify certificate administration.

Subject name format:
Mone

Include e-mail name in subject name

Include this information in attemate subject name:
E-mail name
DNS name
User principal name (LIPN)

Service principal name (SPN)

* Control is disabled due to compatibility settings

ox o | [ e
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Enable the created Template:

5. Click Okay to save the template.
6. In certsrv: go to your current domain > right click Certificate Templates > New > Certificate Template to
Issue and select the template you have just created.

T3l certsry - [Certification Authority (Local)\sb-WIN-AQS6166A090-CA] — O X | f certsrv- [Certification Authority (Local}sb-WIN-AQS61G6A090- CA] -
File Action View Help File Action View Help
e z|lc=H = nldzH
Il Certification Authority (Local) || name Tl Certificatio| 87 Enable Certificate Templates X
> i sb-WIN-AQS61GEA090-CA | = : > Gl sb-WiN
[ Revoked Certficates Select one Certficate Template to enable on this Certfication Authorty.
[ Issued Certificates Note: I a centificate template that was recently created does net appear on this list, you may need to wait unti
1 Pending Requests Information about this temclate has been repiicated to all domain contralers
: 9 e Al of the certficate templates in the organization may not be available to your CA.
[ Failed Requests For more information, see Certificate Template Concepts,
Manage 1. Name Intended Pumpose ~
~ [ OCSP Response Signing OCSP Signing
New ’ Certficate Template to lzsue S & RAS and IAS Server Cliert Authertication, Server Adthentication
Refresh ] Router (Offine request) Client Authentication
7] Smartcard Logon Cliert Authentication. Smart Card Logon
Help & Smartcard User 2. Secure Email, Client Authentication, Smart Card Logen
B Smartcard User AD Smart Card Logon, Client Authentication, Secure Emai
J5 Smartcard User Bitlocker 136.14.131167.1.1
%] Trust List Signing Microsoft Trust List Signing
& User Signature Orly Secure Email, Client Authentication
& Workstation Authertication Client Authentication v
Cancel

6.6.2 Self-enroll Certificate on Client PC

. Certificate Enrollmentwith
AD Certificate Services

e .
EP
. Request Policies from Active Direciory Domain
¢ er (AD DC) via Certificate Enrollment Policy
ervice (CEP)
L icies via CEP to dient
management key

5. Mew public private key pair is generated on iShield
FIDOZ key
6. Gel

Il -
O
C

|||
[
€

]
O
c

ficate signing request ((SR) comprising
ificate template information

Client Computer o G
Certificate Authority (CA)
10. 5R is sent to CA via Certificate Enrollment Service
(CEs) for signing
A ficate is returned to client via CES and

e}
&

B =
imported into iShield Key Pro

]
O
c

O|
C

v
I

iShield Key Pro

This requires you to install the OpenSC Minidriver.

Setup Client certificates management

0n the Workstation log in with the user account for which the smartcard Bitlocker encryption should be activated.
Plug in your smartcard on the client PC.
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1. Go to Start-Menu and search for "Manage User Certificates"
Open Certificates - Current User > Personal > (ertificates and right-click in the blank space
Navigate to A// Tasks > Request New Certificate. The Certificate Enrollment wizard should open

certmgr - [Certificates - Current User\Personal] — O >
File Action View Help
LI AN:) ol = RNHESN 7 Wi
¥ Certificates - Current User Object Type
| Personal
“| Trusted Root Certification Aur There are no items to show in this view.
~| Enterprise Trust
| Intermediate Certification Au
| Active Directory User Object
| Trusted Publishers Find Certificates...
| Untrusted Certificates
- Third-Party Root Certificatior All Tasks ¥ Find Certificates...
.—_ Trgsted People. . Refresh Request New Certificate...
| Client Authentication Issuers k
| Local NonRemovable Certific View ¥ Import...
| Smart Card Trusted Roots Arrange lcons , Advanced Operations 3
Line up lcons
Help
< > || £ >
Request a new certificate from a certification authority (CA) in your demain

Click through it: Select the Active Directory Enrollment Policy then Next
Select the template for the Bitlocker use-case, then £nrol//

An exclamation point should have popped up underneath the Template name (/ick here to configure
settings. Set type to "Common name" and va/ueto Bitlocker; click Add > and 0K

Certificate Properties

G

X | Certificate Properties X | Certificate Properties

£ Subject General Extensions Private Key Certification Authority  Signature A Subject General Extensions Private Key Certification Authority  Signature A, Subject Gereral Extensions Private Key Certification Authority Signature
The subject of a certificate is the user or computer to which the certificate is issued. You

The subject of & certificate is the user or computer to which the certificate is issued. Vou
can enter information about the types of subject name and alternative name values that

The subject of a certificate is the user or computer to which the certificate is issued. You
can enter information about the types of subject name and alternative name values that can enter information about the types of subject name and alternative name values that

can be used in a certificate. can be used in a certificate. can be used in a certificate.

Subject of certificate Subject of certificate Subject of certificate

The user or computer that is receiving the certificate The user or computer that is receiving the certificate The user or computer that is receiving the certificate

Subject name: Subject name: 3. Subject name:

Tpe: Type: e CN=Bitlocker

Full DN - Add > Common name ~ | Common name v Add >

Ty Value: 2. Value:
P — < Remove < Remove < Remove
Ty
Demzin companent Altemnative name:
Email

Alternative name:

Type: 3

Add > Value:

< Remove < Remove =< Remove
Cancd | [ sl canel | | posly conce | [ aeuly

A prompt for the smartcards PIN will show up. After entering the PIN, Windows should display a success message.
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Enable Bitlocker for one storage medium

After this step, you have prepared an external flash drive or (internal) data-disk for Bitlocker. All the present
data will be encrypted retroactively and all future data stored there will be encrypted. Note that this does not
work with boot drives, but only data disks.

Note: For this step, you do not need to install the OpenSC Minidriver and iShield PIV module anymore. As soon as
there is a valid certificate on the iShield Key Pro, the pre-installed Windows tools work by themselves.

Insert the device you want to encrypt in your PC and open it in the Windows Explorer.

e Right-click on the drive and select Turn on BitLocker.

e Check Use my smart card to unlock the drive and click Next.

e Store your recovery key in some secure place. In case you were to lose your iShield Key Pro in the
future, you can still recover your encrypted drive. Click Next.

e For the next options, you can chose whichever you want. Finally click Start encrypting. Depending on
the options you have chosen, this might take a while.

The drive and smartcard have now been prepared to work with Bitlocker on any Windows 10 Pro PC.

6.6.3 Use it on Client

As soon as the iShield Key Pro and external drive are prepared, the default Windows PIV driver is sufficient for
usage with Bitlocker. You will not need to install the OpenSC Minidriver or iShield PIV module in this case.

e Insert your drive. You should see a message "This drive is BitLocker-protected".

e Access the drive via the Explorer. A prompt for your smart card (iShield Key Pro) or your recovery key will
appear.

e Select the "smart card" option and provide your smart card PIN.

e You will find the drive unlocked and usable until you unplug and reinsert it
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6.7 Use Case: Active Directory PC logon

In this scenario, the PC, on which Bitlocker is used, is a workstation within an active directory domain. The
domain server will manage all the domain information. Upon request, the certificate authority on the domain
server will issue and sign the used certificate. This is ideal for companies, in which the AD infrastructure already
exists. You can increase your data security by following the next steps.

This guide expects a working AD setup.

6.7.1 Setup on Server

This section explains the necessary steps to configure a Microsoft Active Directory Domain Server for this use case.
These instructions target the IT Administrator of a domain and you cannot conduct those on a personal computer
or domain workstation.

Requirements beforehand

All users, that want to self-enroll certificates for Logon, need an email address assigned to them in the user
management tool.

In Server Manager:

o Go to 7ools > Active Directory Users and Computers
e Inyour domain go to Users and right click the user
o (lick Properties > General Make sure an email address is assigned to them

Setup Bitlocker Template
On the AD-ROOT-Server, open the Server Manager.

1. In the top right go to 7oo/s > Certification Authority
2. In certsrv expand the server name
3. Right click Certificate Templates > Manage

Setup the Bitlocker Template:

4. In Certificate Templates Console right click Smartcard User > Duplicate Template and adjust the
Properties of each of the tabs as follows:
o Compatibility: leave as-is
o General: Rename (e.g. Smartcard User AD)
o Request Handling: Purpose: Signature and smartcard logon, if warning box appears, click Yes
o Cryptography: Minimum key size: 2048, & Requests must use one of the following providers,
Providers: M Microsoft Base Smart Card Crypto Provider
Security: Authenticated Users > allow Read and Enrol/
Subject Name: & Include e-mail in subject name and M E-mail name

O

Enable the created Template:

5. (Click Okayto save the template.
6. In certsrv: go to your current domain > right click Certificate Templates > New > (ertificate Template to

/ssue and select the template you have just created.

6.7.2 Self-enroll Certificate on Client PC
On the Workstation log in with the user account for which the smartcard logon should be activated. Plug in your
smartcard on the client PC.
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7. Go to Start-Menu and

search for "Manage User Certificates"
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8. Open Certificates - Current User > Personal > Certificates and right-click in the blank space
9. Navigate to A/ Tasks > Request New Certificate. The Certificate Enrollment wizard should open

certmgr - [Certificates - Current
File Action View Help

e dE A NE RS

User\Persanal] — O

H =

x

__qu Certificates - Current Uszer
| Personal
| Trusted Root Certification Au
| Enterprise Trust
| Intermediate Certification Au
| Active Directory User Object
| Trusted Publishers
| Untrusted Certificates
| Third-Party Root Certificatior
| Trusted People
| Client Authentication lssuers
| Local NonRemowvable Certific
| Srnart Card Trusted Roots

Object Type

There are no items to show in this view.

Find Certificates...

All Tasks » Find Certificates...
Refresh Request New Certificate...
View 5 Import...

e e . Advanced Operations

Line up lcons

Help

£ >

<

Request a new certificate from a certification authority (CA) in your demain

10. Click through it: Select the Active Directory Enrollment Policy then Next

1. Select the template for

6.7.3 Use it on Client

From now on, whenever you lock your PC or log out of your account, you will be able to use your Swissbit iShield
Key Pro to logon to your account.

e When you see the logon screen, you should have plugged in your iShield Key Pro.
If it does not automatically prompt you for your “Smart card PIN", you can navigate to "Sign-in

the Logon use-case, then £nrol/

options" and select the Smart card symbol

e Provide the pin of your

iShield Key Pro.

If you have implemented all steps correctly, you should be logged-in by now.

A prompt for the smartcards PIN will show up. After entering the PIN, Windows should display a success message.
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6.8 Troubleshooting

6.8.1 Troubleshooting "The smart card is read-only / cannot perform the requested operation"

If your iShield Key Pro is displayed to be read-only or to not support the requested operation, the OpenSC
minidriver is not properly installed. For provisioning your key you need to use the OpenSC minidriver, see 6.2.1.
Please verify that you correctly installed a compatible OpenSC version including the OpenSC minidriver.

Windows Security b Windows Security b4

Smart Card Smart Card

. Select a smart card device
Select a smart card device

Identity Device (NIST 5P 800-73 [PIV])
Identity Device (NIST SP 800-73 [PIV])
Swisshit iShield Key Pro 0
Swisshit iShield Key Pro 0
The smart card cannot perform the requested

operation or the operation requires a different

The smart card is read-only. i
smart carc.

QK Cancel oK Cancel

6.8.2 Troubleshooting "An internal consistency check failed"

The error "An internal consistency check failed" is commonly caused by misconfiguration of OpenSC. Please make
sure to follow all steps in section 6.4: Verify your OpenSC profiles directory, management key file, environment
variables and OpenSC configuration file, in particular the iShield PIV module path and presence of required system
runtime libraries.

Encrypting File System *

@ An internal consistency check failed,
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7 Glossary

Abbreviation

Description

2FA

Two-Factor Authentication

AD Active Directory

(A Certificate Authority

CEP Certificate Enrollment Policy Service
CES Certificate Enroliment Service

(sp Cryptographic Service Provider
(SR Certificate Signing Request

DC Domain Controller

EFS Encrypting File System

FIDO Fast Identity Online

HMAC Hashed Message Authentication Code
HOTP HMAC-based One-Time Password
IETF Internet Engineering Task Force
iKM iShield Key Manager

MFA Multi-Factor Authentication

NFC Near Field Communication

0IDC OpenlID Connect

0oTP One-Time Password

PIN Personal Identification Number
PIV Personal Identity Verification

PKCS Public-Key Cryptography Standard
PUK Personal Unblocking Key

SSO Single Sign-0n

U2F Universal 2" Factor

VPN Virtual Private Network
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Disclaimer:

No part of this document may be copied or reproduced in any form or by any means, or transferred to any third
party, without the prior written consent of an authorized representative of Swissbit AG (“"SWISSBIT"). The
information in this document is subject to change without notice. SWISSBIT assumes no responsibility for any
errors oromissions that may appear in this document, and disclaims responsibility for any consequences resulting
from the use of the information set forth herein. SWISSBIT makes no commitments to update or to keep current
information contained in this document. The products listed in this document are not suitable for use in
applications such as, but not limited to, aircraft control systems, aerospace equipment, submarine cables, nuclear
reactor control systems and life support systems. Moreover, SWISSBIT does not recommend or approve the use of
any of its products in life support devices or systems or in any application where failure could result in injury or
death. If a customer wishes to use SWISSBIT products in applications not intended by SWISSBIT, said customer
must contact an authorized SWISSBIT representative to determine SWISSBIT willingness to support a given
application. The information set forth in this document does not convey any license under the copyrights, patent
rights, trademarks or other intellectual property rights claimed and owned by SWISSBIT. The information set forth
in this document is considered to be “Proprietary” and "Confidential"” property owned by SWISSBIT.

ALL PRODUCTS SOLD BY SWISSBIT ARE COVERED BY THE PROVISIONS APPEARING IN SWISSBIT'S TERMS AND CONDITIONS OF
SALE ONLY, INCLUDING THE LIMITATIONS OF LIABILITY, WARRANTY AND INFRINGEMENT PROVISIONS. SWISSBIT MAKES NO
WARRANTIES OF ANY KIND, EXPRESS, STATUTORY, IMPLIED OR OTHERWISE, REGARDING INFORMATION SET FORTH HEREIN
OR REGARDING THE FREEDOM OF THE DESCRIBED PRODUCTS FROM INTELLECTUAL PROPERTY INFRINGEMENT, AND EXPRESSLY
DISCLAIMS ANY SUCH WARRANTIES INCLUDING WITHOUT LIMITATION ANY EXPRESS, STATUTORY OR IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

©2023 SWISSBIT AG All rights reserved.
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